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ABSTRAKT 

Obsahem práce je popis tvorby videa z hlediska použitých programů a technologií. Jedním 

z výstupů bakalářské práce je videoklip prezentující možnosti studia na Fakultě aplikované 

informatiky. Úvod práce obsahuje literární rešerši na téma self-promotion se zaměřením na 

propagaci škol a dále popis nejdůležitějších parametrů z oblasti digitálního videa spolu s po-

stupy jeho tvorby. Součástí je vytvoření a popsání scénáře, dle kterého je realizováno nato-

čení samotného propagačního videoklipu a jeho následný střih a postprodukce. Jednotlivé 

body průběhu tvorby jsou popsány a komentovány tak, aby zároveň sloužily jako ukázka 

takové činnosti. 

 

Klíčová slova: propagační videoklip, self-promotion, digitální video, střih, postprodukce.  

 

 

 

ABSTRACT 

The content of thesis is a description of video creation in terms of the programs and techno-

logies used. One of the outputs of bachelor thesis is a video clip presenting studying possi-

bilities at the Faculty of Applied Informatics. Introduction of the thesis contains a literature 

search on the topic of self-promotion with a focus on school promotion and a description of 

the most important parameters in the field of digital video along with the procedures of its 

creation. It includes the creation and description of a script according to which the filming 

of self-promotional video clip is realized and its subsequent editing and post-production. 

Individual points of the production process are described and commented in order to serve 

as a demonstration of such an activity. 

 

Keywords: promotional video, self-promotion, digital video, editing, post-production.   
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ÚVOD 

Interaktivní a komunikační kanál ve formě videa je v době digitalizace atraktivní volbou pro 

zprostředkování poměrně rozsáhlého informačního obsahu v krátkém časovém úseku, a to 

i z důvodu kombinace vizuálního a sluchového vjemu. 

Již při přípravě na natáčení a během tvorby výchozích videosekvencí je nezbytné věnovat 

pozornost důležitým aspektům, které mohou kvalitu výsledného výstupu výrazně ovlivnit. 

Jde zejména o takové parametry, jako je rozlišení videa a snímková frekvence. Společně 

s korekcí barev lze pak během následného zpracování u dostatečně kvalitních podkladů oče-

kávat vizuálně lepší výsledek. Kvalita výsledného videa se ještě umocňuje v případě, že je 

zpracovává zkušený uživatel využívající specializovaných počítačových programů. 

Existuje široká škála programů pro zpracování videa. Každý takový software může být vhod-

nou volbou pro konkrétního koncového uživatele, který se rozhoduje na základě vlastních 

preferencí. Mezi ně lze zařadit například přívětivost uživatelského prostředí, množství do-

stupných funkcí, potřebná kompatibilita nebo další vyžadovaná specifika při využití pro-

gramu.  

Díky rychlému vývoji digitálních technologií je v dnešní době umožněno výstupy prezento-

vat veřejnosti nebo pro soukromé účely například za pomoci cloudového úložiště, prostřed-

nictvím sdílení na sociálních sítích, předáním záznamu na USB flash disku nebo jiném pře-

nosovém médiu. V případě, že se nejedná o osobní či interní záznamy a video lze veřejně 

publikovat, je možnost sdílení krátké prezentace prostřednictvím sociálních sítí velmi vhod-

nou volbou, a to například i z důvodu rychlé zpětné vazby. 

Teoretická část bakalářské práce se zaobírá základní rešerší na téma Self-promotion v oblasti 

propagace škol. Současně detailněji popisuje nejdůležitější parametry digitálního videa a žá-

doucí postup jeho tvorby. 

V praktické části bakalářské práce je popsána realizace výroby propagačního videoklipu 

vztahujícího se k Fakultě aplikované informatiky Univerzity Tomáše Bati (konkrétně k mož-

nosti studia na této fakultě), včetně podrobného postupu formou tutoriálu.  
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I.  TEORETICKÁ ČÁST 
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1 SELF-PROMOTION 

S termínem self-promotion se lze setkat převážně v rámci oboru marketingu a reklamy. Jeho 

význam lze interpretovat jako určitý postup při vytvoření a prezentaci materiálů (za pomoci 

účinných strategií a nástrojů), které jednotlivec nebo organizace používají ke zvýšení pově-

domí o sobě a své přitažlivosti u cílové skupiny zákazníků. Hlavním účelem je tedy propa-

gace a podpora vlastní osoby, firmy nebo produktu. [1], [2] 

Obecně je použití nástrojů v kontextu expanzního šíření jedinečných vlastností, dovedností 

nebo produktů a služeb vedeno záměrem přesvědčit cílovou skupin u o své kvalitě prostřed-

nictvím sebepropagace, a to např. ve formě brožur, webových stránek, propagačních videí 

nebo využitím osobních setkání s potenciálními klienty či zákazníky. [2], [4] 

1.1 Self-promotion v oblasti vysokých škol 

Sebepropagace vysokých škol se převážně předkládá jako soubor aktivit, které mají za cíl 

prezentovat konkrétní školu spolu s nabízenými studijními programy, jejich osnovou a ob-

sahem výuky. Propagují se například specifické úspěchy studentů, výborné výsledky v rámci 

dosažených statistik absolventů a spolupracujících partnerů či dosažení jiných originálních 

okolností. 

• Veřejné události a akce 

Vysoké školy si v rámci reprezentace zakládají na pořádání veřejných událostí a akcí, jako 

jsou dny otevřených dveří a veletrhy pro studenty zajímající se o studijní obory. Sportovní 

utkání nebo například i výstavy lze také považovat za propagační nástroj v oblasti veřejných 

akcí sloužících k rozšíření povědomí uchazečů o konkrétní škole.  

• Propagace prostřednictvím médií 

V odvětví propagace škol se využívá široké škály komunikačních kanálů. Současná mladá 

generace však s ohledem na bezprecedentní dostupnost informací v digitální podobě využívá 

především možnost zjistit potřebné informace na webových stránkách dané instituce, pří-

padně prostřednictvím sociálních sítí.  

• Certifikace a spolupráce 

Nedílnou součástí v oblasti úspěchu propagace vysoké školy je prezentace ocenění a certifi-

kací ve vzdělávacích i dalších aspektech. V této oblasti je naprosto nezbytná spolupráce se 

soukromými subjekty, která má jednak pozitivní vliv na dostupnost vyučovaných praktik 
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a současně rozšiřuje možnosti získávání certifikačních ocenění pro studenty, což se pak po-

zitivně odráží na možnostech pracovního uplatnění absolventů. 

• On-site propagace 

Prezentovat své vzdělávací programy a kurikulum přímo ve svých prostorách mohou školy 

především prostřednictvím tištěných informačních materiálů, průvodců, videí nebo prezen-

tací. Cílem je opět přesvědčit potenciální studenty a rodiče o kvalitě vzdělání na dané 

škole.[3] 

1.2 Univerzita Karlova 

Své pojmenování nese po významném českém králi Karlu IV. – byla jím založena roku 1348 

v Praze. Jedná se o největší a zároveň i nejstarší českou univerzitu. Svou strukturou je značně 

rozsáhlá, skládá se celkově ze sedmnácti fakult a v současné době je rozšířena do tří měst 

v rámci České republiky – Praha, Plzeň a Hradec Králové. Univerzita Karlova se pyšní 889 

nabízenými studijními programy, uvádí aktuálně přes 51 000 studujících a 97,7 % jejích ab-

solventů získá zaměstnání do jednoho roku od dokončení studia. [5], [6] 

V rámci propagačních a publikačních projektů se Univerzita Karlova angažuje například 

v produkci podcastů, tiskových propagačních materiálů a časopisu Forum, který je veden jak 

v elektronické, tak tištěné podobě. Časopis popisuje dění a novinky na univerzitě ve formě 

rozhovorů, anket a reportáží, ale zmiňuje například i nové technologie a pokrok. 

Univerzita Karlova vyniká konkrétní propagací každé jedné fakulty na svém YouTube ka-

nále. Videa jsou konceptualizována ve formátu hlavního protagonisty, lépe řečeno průvodce, 

který v krátkém propagačním klipu zmiňuje hlavní obory na dané fakultě a představuje její 

prostředí. Nechybí ani vysvětlení, proč si zrovna tuto vysokou školu vybrat, co od studia 

očekávat a kde trávit volný čas. 

Již samotnou dlouholetou historii Univerzity Karlovy a její prestiž u veřejnosti lze považovat 

za samostatný náborový nástroj. Významné postavení v oblasti vědy, výzkumu a vzdělávání 

je rovněž klíčem k přilákání talentovaných studentů a akademiků, a to nejen z České repub-

liky. Škola má mezinárodní renomé, které se v průběhu uplynulých staletí dostalo do pově-

domí široké škály lidí. [6] 
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1.3 Mendelova univerzita v Brně 

Univerzita byla založena v roce 1919 pod tehdejším názvem Vysoká škola zemědělská. Nese 

pojmenování po Johannu Gregoru Mendelovi, a to od roku 1994. V rámci českých vysokých 

škol se jedná o nejstarší univerzitu vyučující zemědělské a lesnické obory. Mendelovu uni-

verzitu tvoří pět fakult, které uchazečům nabízejí dohromady přes více než 150 studijních 

oborů a aktuálně ji navštěvuje přes 8 900 studentů. [7], [8] 

Při popisu propagace Mendelovy univerzity v Brně je nutno zmínit estetické webové 

stránky, které fungují jako reprezentativní a komunikační kanál s případnými uchazeči nebo 

návštěvníky. Funkčním aspektem je vysoká míra přehlednosti webu i samotné navigace 

umožňující uživatelům snadné vyhledávání potřebných informací. 

Jako výrazné specifikum prezentující Mendelovu univerzitu je třeba zmínit zemědělské 

statky, botanické zahrady, arboreta a jiné přírodní pozemky. Vybraná místa může navštěvo-

vat za příznivé ceny i veřejnost a o správu se starají převážně studenti příslušných fakult 

v rámci praktické výuky. [8] 

Univerzitní časopis Mendel Green je propagačním nástrojem přinášejícím informace a no-

vinky nejen z dění na univerzitě. Texty obsažené v každém vydání jsou zaměřeny jak na 

oblast edukace a informovanosti, tak na sdělení o dostupných možnostech pro studenty. 

Jedno z čísel například vyvrací genderové stereotypy, statisticky znázorňuje a porovnává 

úrovně sucha v České republice nebo propaguje dostupnost pomoci studentům v rámci po-

radenského a profesního centra. [9], [10] 

1.4 Masarykova univerzita 

Historie Masarykovy univerzity se začala psát od roku 1919, kdy byla založena jako druhá 

česká univerzita a skládala se z fakulty Lékařské, Právnické, Filozofické a Přírodovědecké. 

Jejímu zrodu předcházela dlouhá snaha o vytvoření moderní vysokoškolské instituce v Brně, 

která by byla schopna konkurovat již existující univerzitě v Praze a zároveň i univerzitám 

v dalších evropských metropolích.  

Univerzita od počátku nese název po prvním československém prezidentovi, kterým byl To-

máš Garrigue Masaryki, jehož myšlenky o demokracii, vzdělání a vědě byly hlavním impul-

sem pro její založení. Masarykova univerzita byla zřízena jako moderní vzdělávací instituce, 

která měla propagovat vědecký pokrok, kritické myšlení a demokratické hodnoty.  
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V průběhu své existence prošla Masarykova univerzita řadou transformací i rozšířením aka-

demického působení. V současnosti se skládá z deseti fakult. V roce 1990 byla zřízena Eko-

nomicko-správní fakulta, v roce 1994 se utvořila Fakulta informatiky a posledními třemi 

přírůstky byly Fakulta sociálních studií, Fakulta sportovních studií a v roce 2020 obnovená 

Farmaceutická fakulta.  

Při prezentaci osobitostí týkajících se Masarykovy univerzity v Brně je například zmiňo-

váno, že se škola přiblížila nejen směrem k novým technologiím, ale zvýšila přístupnost pro 

studenty vyžadující pomoc ve sféře různých typů zdravotních znevýhodnění. V roce 2000 

bylo otevřeno středisko Teiresiás, které zajišťuje, aby studijní obory akreditované na univer-

zitě byly v největší možné míře přístupné i studentům nevidomým, neslyšícím, s pohybovým 

handicapem, případně jinak postiženým. Roku 2006 byla otevřena výzkumná vědecká sta-

nice na Antarktidě, která slouží mimo jiné ke zkoumání změny klimatu. V odvětví kultury 

se univerzita angažuje například správou Mendelova muzea a kina Scala. [11], [12] 

V rámci spolupráce se soukromým sektorem Masarykova univerzita umožňuje firmám tzv. 

„recruitment“ neboli nábor studentů z široké škály dostupných oborů. Nabízí například zpro-

středkování výběrového řízení nebo zadání ročníkové práce, ze které bude společnost profi-

tovat. Jako výhodný aspekt partnerství s univerzitou je prezentováno i případné poskytnutí 

přednáškových místností a jiných prostor. [12] 

1.5 Vysoké učení technické v Brně 

Vysoké učení technické v Brně (VUT) se celkově skládá z osmi fakult, mezi které se řadí 

Fakulta stavební, Fakulta strojního inženýrství, Fakulta elektrotechniky a komunikačních 

technologií, Fakulta architektury, Fakulta chemická, Fakulta podnikatelská, Fakulta výtvar-

ných umění a Fakulta informačních technologií. [13], [14] 

Široká variabilita fakult, jejich oborů a z toho plynoucí rozsáhlé možnosti výběru zaměření 

studia pro případné uchazeče je akcentována i v propagačním videu nesoucím název Profi-

lové video VUT na sociální platformě YouTube. Jedná se o klip, který představuje a prezen-

tuje jednotlivé fakulty v atraktivním formátu za doprovodu hlasového komentáře. Hlavní 

myšlenkou je předat důležité informace ve stručném časovém intervalu a zaujmout nejen 

případné nově příchozí studenty, ale i širší veřejnost. 

Ve sféře propagace se Vysoké učení technické v Brně angažuje například i v organizaci kul-

turních akcí, jako je Ples VUT, Festival vědy a techniky apod. Oproti jiným vysokým školám 

https://cs.wikipedia.org/wiki/Fakulta
http://www.muni.cz/econ
http://www.muni.cz/econ
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Vysoké učení technické v Brně výrazně investovalo do reklamních předmětů, kterých je ne-

spočetné množství – za zmínku stojí trička, zápisníky, trhací bloky, pera, tužky, deštníky 

atd. K zakoupení jsou každý všední den ve vymezeném čase na Fakultě podnikatelské. [14] 

1.6 Univerzita Palackého v Olomouci 

Univerzita Palackého v Olomouci je známá svou spoluprací s domácími i zahraničními vý-

zkumnými institucemi. Vědecké týmy se angažují v širokém spektru disciplín, od přírodních 

a technických věd po společenské a humanitní obory. Univerzita Palackého je složena z cel-

kem osmi fakult, kterými jsou Cyrilometodějská teologická fakulta, Lékařská fakulta, Filo-

zofická fakulta, Přírodovědecká fakulta, Fakulta tělesné kultury, Právnická fakulta a Fakulta 

zdravotnických věd. 

Mimo akademické aktivity se Univerzita Palackého také podílí na kulturním a společenském 

životě města Olomouc. Poskytuje prostor pro setkávání studentů, pořádá kulturní akce, ve-

řejné přednášky a výstavy a aktivně se zapojuje do rozvoje regionu. 

Univerzita Palackého se při své webové prezentaci odlišuje od ostatních vysokých škol 

zejména tím, že se na úvodní straně nijak výrazně nezaměřuje na uchazeče, ale soustředí se 

na zobrazení novinek. V rámci propagace ale škola využívá i vlastní mobilní aplikaci s ná-

zvem „UPlikace“. Aplikace je určena primárně pro studenty – zajišťuje například přehledný 

rozvrh s předměty a zkouškovými termíny, zasílání důležitých notifikací, ale obsahuje i sekci 

pro zájemce o studium, jejíž součástí je průvodce s přehledem o univerzitě a důležité odkazy 

nebo termíny akcí, na kterých se lze dozvědět více o studiu. [74], [75] 

1.7 Univerzita Tomáše Bati ve Zlíně 

Historie vysokoškolského studia ve Zlíně započala už ve druhé polovině 20. století, když 

zde v roce 1960 vzniklo detašované pracoviště Slovenské vysoké školy technické se zamě-

řením na chemické a strojírenské technologie, které se poději vyvinulo v samostatnou Fa-

kultu technologickou Vysokého učení technického. Roku 1995 pak vznikla Fakulta ma-

nagementu a ekonomiky, která v roce 2001 společně s Fakultou technologickou vytvořila 

základ univerzity, jež nese v názvu jméno významného zlínského rodáka a podnikatele To-

máše Bati. S rostoucím zájmem o studium byla později přidána Fakulta multimediálních ko-

munikací, následovaly Fakulta aplikované informatiky, Fakulta humanitních studií a jako 

poslední Fakulta logistiky a krizového řízení, která je specifická svou lokalizací mimo Zlín. 

[15], [16] 
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Univerzita Tomáše Bati ve Zlíně (stejně jako např. již zmíněná Mendelova univerzita 

v Brně) ve směru sebepropagace udržuje komplexní a interaktivní webové stránky poskytu-

jící detailní informace o všech fakultách, studijních programech, výzkumných projektech, 

akademickém personálu a událostech. Webové stránky jsou aktualizovány pravidelně a na-

bízejí uživatelům možnost rychle a snadno se seznámit s nabídkou. [16] 

Každá fakulta se rovněž propaguje svou vlastní formou na sociální platformě YouTube, kde 

prezentuje dostupné studijní programy v krátkém, atraktivním a informačním formátu vi-

dea. V rámci Fakulty aplikované informatiky byla zvolena jiná forma prezentace, přičemž 

záměr je orientován na průvodce představujícího prostory fakulty interaktivním způsobem, 

jenž umožňuje si prohlédnout prostředí z pohledu první osoby s možností otáčení v 360 stup-

ních. V rámci novodobých trendů univerzita nezaostává a založila podcast s názvem „UTB 

utebe“, jenž obsahuje například příběhy absolventů, kteří líčí svůj pracovní a osobní život, 

ale i rozhovory se známými vědci atd. [16], [17] 

Univerzita pomáhá studentům nalézt pracovní uplatnění jak v průběhu vzdělávání, tak po 

úspěšném absolvování příslušného oboru skrze portál Job Centra UTB. Mimo jiné nabízí 

i příležitost pro firmy – pomoc při inzerci pracovních nabídek a hledání ideálních uchazečů. 

Jednou ročně se ve Zlíně koná akce s názvem Business Day. Jedná se o veletrh firem nabí-

zejících pracovní příležitosti a stáže. Jednotlivé společnosti se zde prezentují svými reklam-

ními předměty a vystavenými bannery s označením, které odpovídá číslu na plánku s mapou. 

[18], [19] 
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2 DIGITÁLNÍ VIDEO A JEHO PARAMETRY 

Digitální video je kvalitativně ovlivněno různými parametry a ve sféře videotvorby se ze 

subjektivního úhlu pohledu mohou názory na nejpodstatnější kritéria digitálního videa vý-

razně různit. Mezi objektivně nejdůležitější se však řadí rozlišení, datový tok, video a audio 

kodeky, užitý kontejner, snímková frekvence, definice rozsahu barev, formát souboru a s tím 

spojená kompatibilita. Zvolené parametry mají zásadní vliv na finální výstup, a proto je ne-

zbytné je vhodně vybrat. A to jak na základě publika, pro které je tvorba videa určena, tak 

na základě využívaného technického zařízení a příslušného nastavení pro dosažení požado-

vaného výsledku. [20] 

2.1 Rozlišení videa a poměr stran 

Rozlišení videa vyjadřuje podstatný parametr určující výslednou kvalitu obrazu a jeho de-

tailnost, respektive počet pixelů, které se zobrazují. Udává počet pixelů ve vertikálním a ho-

rizontálním směru a definuje počet obrazových bodů, které tvoří obraz. Čím vyšší je rozli-

šení, tím větší je počet pixelů, ale i velikost souboru na úložišti. 

Poměr stran je matematický vztah mezi šířkou a výškou obrazu, který určuje jejich proporce. 

Jako standard rozlišení počítačových obrazovek při poměru stran 16:9 se v nynější době 

uvádí 1920x1080 (FullHD), případně 2560x1440 (QHD) nebo 3840x2160 (4K). Na příkladu 

rozlišení označovaného jako FullHD lze demonstrovat, že první hodnota, která se uvádí jako 

počet sloupců na šířku (horizontální osa), obsahuje 1920 pixelů a druhá hodnota označovaná 

jako počet řádků na výšku (vertikální osa) obsahuje 1080 pixelů. [20], [21], [22], [23] 

Proporce poměrů stran však nemusí být jen 16:9, ale třeba i 4:3, 21:9 apod. Zvolení tohoto 

poměru se odvíjí i od zaměření na cílovou skupinu, respektive platformu či technické zaří-

zení určené k finální publikaci videa. Například v případě zveřejnění na sociální sítě typu 

Instagram nebo TikTok je standardem vertikální rozložení videa a z toho vyplývající pří-

slušný poměr stran, který je na většině mobilních zařízení normalizován na 9:16. V rámci 

zákaznického trhu v oblasti elektroniky je stále větší poptávka po tzv. UltraWide typech mo-

nitorů, přičemž zpravidla bývají tyto monitory prohnuté a poměr jejich stran bývá většinou 

21:9. [20], [22], [23], [24] 



UTB ve Zlíně, Fakulta aplikované informatiky 17 

 

2.2 Poměr stran pixelu 

Poměr stran pixelu (PAR) je proporcionální vztah pixelů obrazu, jinými slovy poměr šířky 

pixelu k jeho výšce. Například poměr stran pixelu 2:1 znamená, že každý pixel je dvakrát 

širší, než je jeho výška. Většina digitálních obrazů má čtvercové pixely s poměrem stran 1:1, 

i když některé používají obdélníkový poměr stran z důvodu kompatibility s televizními for-

máty standardního rozlišení, které používají obdélníkové pixely s odlišnou šířkou a výškou. 

PAR je způsob, jakým se tento rozdíl popisuje. 

S pojmem poměr stran pixelů se obvykle lidé setkají v souvislosti s televizními formáty 

standardního rozlišení a některými zvláštními případy. Většina ostatních zobrazovacích sys-

témů včetně těch, které splňují standardy a postupy stanovené SMPTE, ale využívá pixelů 

čtvercových.  

U digitálních obrazů se rozlišuje poměr stran paměti (SAR), což je poměr rozměrů pixelů. 

Pokud je obraz zobrazen pomocí čtvercových pixelů, pak se tyto poměry shodují, ale pokud 

tomu tak není (jsou použity obdélníkové pixely), poměry se neshodují. [25], [26] 

2.3 Datový tok 

Datový tok neboli bitrate je vyjádření množství dat přenesených za jednotku času, zpravidla 

za sekundu. Jedná se o parametr, který má vliv na velikost a kvalitu digitálního videa, ovšem 

ta je ovlivněna i dalšími faktory. Základní jednotka se vyjadřuje v b/s (bitů za sekundu). 

Nynějším standardem je však udávání jednotek v násobcích – kb/s (kilobitů za sekundu), 

Mb/s (megabitů za sekundu) a Gb/s (gigabitů za sekundu). [27] 

Měřítko datového toku je určující pro velikost výsledného videosouboru. Použití nadbytečně 

vysoké přenosové rychlosti může mít ale negativní vliv na využití šířky pásma. Využívají se 

dvě metody datového toku. 

První metodou je datový tok konstantní (CBR), který stanovuje, že po celou dobu nahrávání 

videa zůstává datový tok neměnný. Veškerá data jsou přenášena konstantní rychlostí, i když 

není v obraze žádný pohyb. Dochází tak k neefektivnímu využití přenosového kanálu. Ne-

výhoda této metody spočívá v nutnosti vyhrazení většího objemu místa na úložném médiu. 

Výhodným aspektem je, že lze předem odhadnout velikost výsledného souboru, což usnad-

ňuje plánování a správu úložného prostoru.  
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Druhou metodou je variabilní datový tok (VBR) – představuje strategii optimalizace kvality 

videa při minimalizaci přenesených dat. Principem je proměnlivě přizpůsobovat bitrate dle 

aktuálních potřeb pro zachování požadované úrovně kvality. V případě scén s vysokým po-

hybovým obsahem je datový tok vyšší, ale ve statických scénách nižší. Tato metoda umož-

ňuje dosáhnout vyšší kvality videa než u metody konstantního toku dat (CBR). [28], [29] 

2.4 Snímková frekvence 

Snímková frekvence (anglicky Framerate) udává počet přehrávaných nebo zaznamenaných 

snímků za jednotku vyjádřenou v sekundách – FPS (Frames Per Second). Tato frekvence 

určuje, jak plynule jsou pohyby zobrazeny v přehrávaném videu. Vyšší snímková frekvence 

znamená plynulejší pohyb a realističtější zážitek z obrazu.  

Použití adekvátní snímkové frekvence se odvíjí od cíle promítání a existuje tak různorodá 

škála užívaných standardů. Často aplikovatelnými normami jsou v sektoru filmu snímkové 

frekvence o 24 FPS, a to již z dávnější historie. Dříve bylo totiž potřeba zavést optimální 

řešení splňující požadavek synchronizace zvuku a přehrávaného videa tak, aby byl obraz 

plynulý a co nejméně ekonomicky nákladný. Úroveň kinematografického zážitku se i do 

dnešní doby promítla používáním stále stejného standardu. Představuje totiž ideální vyvá-

žení mezi určitou mírou rozmazání pohybu a charakteristického rytmu pohybu, který je vní-

mán diváky jako přirozený a skutečný. Televizní vysílání zpravidla mají snímkovou frek-

venci o 25 nebo 30 FPS a v případě prokládaného režimu 50 nebo 60 FPS. [30], [31], [33] 

U rozlišení videa, které je zároveň spjato se snímkovou frekvencí, se lze setkat s označením 

například 720p nebo 1080i. V případě koncového písmena ,,p“ se jedná o progresivní (ne-

prokládané) video, které je tvořeno kompletními snímky. U interlaced (prokládaného) videa 

označovaného koncovým písmenem ,,i“ dochází ke střídání půlsnímků vyobrazených v li-

chých a následně sudých řádcích a výsledkem jsou dva odlišné snímky. 

Frekventovaně používaným standardem je v současné době, kdy dochází k rozsáhlé publi-

kaci videoobsahu na sociální sítě, snímková frekvence 60 FPS – obraz působí plynuleji 

a jedná se o vhodnější alternativu oproti 30 FPS. V případě sledování videoher či obsahu 

z akčních kamer je vhodné využít ještě vyšší FPS, kvůli potřebě hladšího vyobrazení. [31], 

[32] 
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2.5 Video kodeky 

Pro účely zmenšení objemu velikosti souboru a zachování co nejvyšší kvality videostopy se 

využívají tzv. kodeky. Jedná se o počítačový software nebo hardware, který kóduje/dekóduje 

za účelem komprese/dekomprese data, což lze interpretovat jako redukci velikosti videa 

s odstraněním redundantních informací a zachováním pouze těch, které jsou potřeba k ná-

sledné rekonstrukci videoobrazu při zobrazování. 

Výběr konkrétního typu kodeku se odvíjí od jednotlivých charakteristik a optimalizací pro 

širokou škálu aplikací a cíle využití (streamování videa, vysoká rozlišení pro prezentace na 

velkých plochách apod.). Video kodeky se dále rozlišují (dle již zmíněné komprimace) na 

ztrátovou a bezeztrátovou kompresi. 

Ztrátová komprimace redukuje velikost souboru odstraněním méně podstatných informací, 

a to převážně na základě využití nedokonalosti zrakového a v případě audio kodeků i slu-

chového vjemu člověka. Vyloučeny bývají zpravidla detaily nebo přesné hodnoty jako 

jemné textury, barevné nuance nebo vysokofrekvenční složky, které ve finální podobě pouze 

degradují a jsou téměř nerozeznatelné ve srovnání s nekomprimovaným souborem. Je 

vhodné však zmínit, že se měřítko zkreslení odvíjí od míry kompresního poměru. V případě 

zvolení vysokého komprimačního poměru dochází ke znehodnocení obrazu a stává se prak-

ticky nepoužitelným.  

Bezeztrátová komprese dat snižuje velikost souboru bez nežádoucí ztráty informací nebo 

kvality. Proces komprimace je založen na principu využití algoritmů a technik identifikují-

cích redundantní nebo nepodstatné informace a jejich následném nahrazení efektivnějšími 

kódy nebo způsoby záznamů. V praxi se využívají převážně při archivaci dat, zálohování 

souborů a komprimaci grafických a textových prvků s nutností zachování čitelnosti a přes-

nosti informace. [34], [35], [36] 

2.5.1 MPEG-1 

MPEG-1 je standard pro audio a video komprimaci vyvinutý skupinou Moving Picture Ex-

perts Group. První verze byla publikována v roce 1991 a jedná se o formát, který je jedním 

z průkopníků v rámci standardů pro digitální kompresi audiovizuálního obsahu. MPEG-1 

umožňuje komprimovat video a zvuk do relativně malých souborů s minimální ztrátou kva-

lity. Tento standard byl využíván především pro digitální videa na kompaktních discích (CD) 

a jako základní formát pro videa na internetu v raných fázích jeho vývoje. Do dnešního dne 
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je stále dostupná jeho podpora v široké škále multimediálních přehrávačů a softwarů pro 

úpravu videa. [36], [38], [39] 

2.5.2 MPEG-2 

Formát Moving Picture Experts Group 2 byl poprvé publikován v roce 1995 jako následov-

ník standardu MPEG-1. Poskytuje vylepšenou kompresi a vyšší kvalitu obrazu a zvuku než 

jeho předchůdce. Tento standard se stal široce využívaným pro digitální televizní i satelitní 

vysílání a DVD videa. [36], [39] 

2.5.3 DivX 

DivX je firma vyvíjející svůj kodek se stejnojmenným názvem a využívá standartní kompa-

tibilní formát kódování videa MPEG-4 ASP. První generace kodeku DivX byla označena 

verzí 4.0. Firma uvedla na trh svůj produkt nesoucí název DivXNetworks, ale došlo ke kon-

troverzím v rámci nelegálně upraveného MPEG-4 od Microsoftu, který ovšem nebyl kom-

patibilní s tehdejším standardem. Firma dále vyvíjela kodek a došlo k postupným aktualiza-

cím. Od verze 7 již DivX podporuje kompresi formátu H.264. [40] 

2.5.4 Xvid 

Xvid je kodek, který kóduje a dekóduje formát MPEG-4 ASP a často je zaměňován právě 

za kodek DivX. Svou popularitu a rozsah využití získal převážně kvůli dostupnosti, byl totiž 

zaveden formou open-source a nabízen zcela zdarma. Atraktivní využití lze najít ve velké 

variabilitě v rámci konfigurovatelnosti a podpoře rozlišení obrazu až do 1920x1080 (tedy 

FullHD). [41] 

2.5.5 H.264 

AVC (Advanced Video Coding), převážně známý jako kodek H.264, se stal jedním z nejpo-

pulárnějších a nejúspěšnějších kodeků pro videokompresi. Byl navržen tak, aby poskytoval 

vyšší komprimační efektivitu než jeho předchozí standardy. Výhodou je vysoká kvalita vi-

deostopy při relativně nízkých datových tocích, nabízí se tak využití pro přenos a streamo-

vání videa přes internet a digitální televize.  

Video kodek H.264 zakládá svou pokročilou technologii na upravených technikách kom-

prese včetně predikce pohybu, transformace bloků, kvantizace a kódování entropie tak, aby 

byl dbán důraz na vysokou úroveň komprimace při zachování vysoké úrovně kvality videa. 
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Jedná se o jeden z nejrozšířenějších kodeků, a proto je stále kompatibilní s širokou škálou 

aplikací, a to i přes příchod nástupce – novějšího formátu H.265. [37], [42] 

2.5.6 H.265 

HEVC (High Efficiency Video Coding) – populární kodek nesoucí označení H.265 je vy-

lepšeným nástupcem verze kodeku H.264. Byl vyvinut s cílem dosažení ještě vyšší úrovně 

komprimace a lepší kvality videa při zachování co nejnižších datových toků. 

Vylepšené algoritmy umožňují kodeku H.265 docílit výrazné úspory datového toku při za-

chování vysoké kvality videa, a to i se zachováním většího objemu detailů. Oproti svému 

předchůdci (H.264) dosahuje efektivnějšího přenosu videa přes internet a digitální televizní 

sítě. Z velké části bývá uplatňován na mobilních zařízeních a využíván pro streamování vi-

dea ve vysoké kvalitě. Stále však zcela nenahradil svého předchůdce a je teprve postupně 

zaváděn do praxe. [37], [43] 

2.6 Zvukové kodeky 

Definice zvuku je interpretována jako fyzikální jev vznikající důsledkem mechanických vib-

rací nebo kmitání látkovým prostředím. Lidský sluchový vjem je subjektivní – většina lidí 

je však schopna zaznamenat frekvenci vlnového kmitání udávanou v jednotkách Hz (hertz), 

a to v rozmezí 16 Hz – 20 000 Hz. Vrchní mez se převážně označuje v jednotkách násobků 

(20 kHz = 20 kilohertz). [44], [45] 

Infrazvukem se rozumí vlnění, jehož hranice je udávána pod mírou 16 Hz. Kvůli nedokona-

losti lidského sluchového vjemu jej člověk není schopen zaznamenat. Jedná se převážně 

o jevy – chvění půdy, kmity budov nebo zemětřesení. K postřehnutí těchto anomálií se vyu-

žívá tzv. seismograf, který registruje infrazvukové vlny. [44], [47] 

Vyšší frekvence akustického vlnění, než bývá horní mez lidského sluchu (20 000 Hz), je 

definována jako ultrazvuk. Využití nachází v různorodém odvětví, např. v medicíně, prů-

myslu a vědě. [44], [46] 

Audiostopa je neoddělitelnou součástí celkového zážitku z přehrávání filmů, televizních po-

řadů nebo jiných vizuálních médií. Kvalita a reprodukce při vytváření reprezentují vyváže-

nou atmosféru spolu s emotivním a autentickým prostředím. Vyvážením těchto a dalších 

aspektů je určena jistá relevance pro celkovou percepci profesionálnosti obsahu. 



UTB ve Zlíně, Fakulta aplikované informatiky 22 

 

Audiovstupy jsou zpravidla digitalizovány a integrovány do videozáznamu, nejčastěji obsa-

hují dialogy postav, zvukové efekty a hudební doprovod.  

Při tvorbě audiovizuálního obsahu je nezbytné dbát na kvalitu nahrávání zvuku, správné vy-

vážení hlasitosti, eliminaci nežádoucího šumu a nahrávání jasného a čistého zvuku. Kvalita 

audiozáznamů zajišťuje významnou prosperitu v rámci celkového dojmu z videa a posílení 

jeho účinku na diváka. Stejně jako u videa je nezbytné vybrat vhodný formát a kodek pro 

optimalizaci velikosti souboru a zachování kvality při přenosu a uložení. [44] 

2.6.1 Audio kodeky 

Audio kodeky jsou softwarové nebo hardwarové algoritmy určené ke kompresi a dekompresi 

zvukových dat. Redukují velikost audiosouborů tak, aby bylo možné efektivněji přenášet 

nebo ukládat zvuková data. Přitom zachovávají nejvyšší možnou úroveň kvality, nebo nao-

pak dekomprimují data za účelem obnovení původní zvukové informace. Stejně jako u video 

kodeků se i zvukové kodeky rozdělují na ztrátové a bezeztrátové. V nynější době existuje 

široká škála audio kodeků s různými úrovněmi komprese a kvality zvuku. Uplatňují se ve 

velkém sortimentu aplikací, včetně streamování hudby a podcastů, záznamu zvuku a vytvá-

ření zvukových efektů v zábavním průmyslu. [48] 

• WAV 

WAV je standardní bezeztrátový audioformát vyvinutý pro ukládání digitálního audia ve 

formě nekomprimovaných PCM (Pulse Code Modulation) dat. Soubory obsahují zvuková 

data ve formě vzorků, které jsou uloženy s pevným datovým tokem a vzorkovací frekvencí. 

Tento formát je charakteristický svou schopností uchovávat velmi vysokou kvalitu zvuku 

bez jakékoli ztráty, a tudíž je vhodným nástrojem pro profesionální nahrávání a zpracování.  

[49] 

• FLAC 

Free Lossless Audio Codec je bezplatný, otevřený audio kodek určený pro bezpečné a ztrá-

tově nenarušené komprimování zvukových souborů. FLAC disponuje účinnými schop-

nostmi kompresních technik a algoritmů a poskytuje vysokou kvalitu zvuku při zachování 

úplné integrity zvukových dat. Reprezentuje se tedy jako ideální formát pro archivaci zvu-

kových nahrávek a následný kvalitní poslech hudby s nižším objemem datové náročnosti na 

úložiště. [50], [51] 
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• APE/MAC 

Monkey’s Audio (známý pod označením APE/MAC) je audio kodek vyvinutý se záměrem 

na bezeztrátovou kompresi zvukových souborů. Využívá prediktivních kompresních tech-

nik, které identifikují a odstraňují redundantní informace ve zvukových datech, aniž by ná-

sledně ovlivnily jejich kvalitu. Kodek byl navržen s myšlenkou zpětné kompatibility, tudíž 

je schopen obnovy audiosouborů bez jakýchkoli ztrát, a to i po opakovaném komprimování 

a dekompresi. [52], [53] 

• MP3 

MP3 je ztrátový a nejspíš i nejpopulárnější audio kodek. Díky své kompatibilitě a efektiv-

nosti je používán v širokém spektru aplikací pro kompresi zvukových souborů. Byl vyvinut 

s důrazem na vysokou komprimační efektivitu při zachování přijatelné kvality zvuku. 

Funguje na principu odstranění frekvencí zvukového signálu, které jsou v rámci nedokona-

losti lidského sluchového vjemu vnímány pouze zanedbatelně nebo vůbec. Využívá psycho-

akustických modelů k určení, které informace lze odstranit s minimálním vlivem na subjek-

tivní kvalitu zvuku. [54] 

• AAC 

Advanced Audio Coding byl vyvinut jako nástupce staršího kodeku MP3 s poskytnutím lepší 

kompresní efektivity při zachování, nebo dokonce zlepšení zvukové kvality, a to při nižších 

datových tocích. [55], [56] 

2.7 Multimediální kontejnery 

Multimediální kontejnery jsou speciální typy souborů sloužící k uchování a organizaci růz-

norodých typů dat zahrnující video, audio, titulky atp. Funkcionalita je založena na formě 

,,obalů“ obsahujících jedno nebo více proudů dat odlišných formátů a kódování. Zároveň 

poskytují metadata a další informace potřebné pro adekvátní přehrávání a editaci multime-

diálního obsahu. Mezi nejčastěji používané kontejnery se řadí formáty typu MP4, AVI 

a MOV. Každý jednotlivý formát obsahuje vlastní charakteristiky a případně se odlišují 

v oblasti podporovaných kodeků. [57], [58] 
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2.7.1 AVI 

Audio Video Interleave (známý pod označením AVI) je multimediální kontejner určený 

k uchování audiovizuálních dat v digitální podobě. Jedná se o jeden z nejstarších a v minu-

losti i nejpoužívanější formát pro platformu Windows. Popularitu získal i značnou možností 

kompatibility s populárními kodeky jako je DivX, Xvid, MPEG-4. Další neocenitelnou vý-

hodou byla podpora v multimediálních přehrávačích a editačních softwarových aplikacích. 

Značnou nevýhodou formátu AVI je však absence podpory pro kompresi s vysokým rozli-

šením. Přehrávačům nesděluje žádné informace o poměru stran a soubory dosahují větší ve-

likosti v případě porovnání s jinými modernějšími kontejnery. [59], [60] 

2.7.2 MOV 

Společnost Apple vyvinula proprietární multimediální kontejner s označením MOV speci-

álně pro použití s programem QuickTime Player. Je možné ho použít i na jiných platformách, 

ale nedosahuje tak velkých kompatibilních možností jako téměř identický formát MP4, který 

je mezinárodním standardem a pracuje s více streamovacími protokoly. Rozdíly mezi těmito 

multimediálními kontejnery však lze registrovat v kvalitě, která je v případě kontejneru 

MOV na lepší úrovni, ale zároveň dochází k vyšším velikostem souborů. [57], [60], [61] 

2.7.3 MKV 

MKV (také nazýván jako Matroska) je otevřený kontejnerový formát určený pro ukládání 

multimediálních dat, jako jsou video, audio, titulky a metadata. Jedná se o formát, který 

podporuje širokou škálu kodeků pro kompresi a dekompresi videa a zvuku. Zároveň je na-

vržen tak, aby byl univerzální a kompatibilní s různými platformami a zařízeními. [59], [60], 

[62] 

2.7.4 MP4 

Multimediální kontejner MP4 je vylepšeným nástupcem kontejneru AVI a stal se jedním 

z nejrozšířenějších a nejpopulárnějších formátů pro ukládání digitálního multimediálního 

obsahu díky efektivnímu zkombinování audia, videa, titulků a dalších dat do jednoho sou-

borového celku při zachování vysoké úrovně kvality. Pozitivním aspektem MP4 je uživatel-

ská přívětivost v rámci usnadnění sdílení, ukládání a přehrávání na odlišných zařízeních 

a platformách. 
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Podporuje širokou škálu kodeků pro kompresi audio a video dat spolu s pokročilými funk-

cemi zahrnujícími kapitoly, interaktivní menu a 3D video. Podporované jsou populární ko-

deky – například H.264 pro video a AAC pro audio. Rozsáhlé uplatnění lze promítnout do 

množství multimediálního obsahu, videoklipů, televizních pořadů i kinematografie. [57], 

[59], [60], [61] 

2.8 Postup tvorby digitálního videa 

Vytvoření digitálního videa je komplexní proces vyžadující pečlivé plánování, precizní pro-

vedení a kreativní myšlení. Prvním nezbytným krokem musí být jasná definice cíle a vize 

videa, které odpovídají potřebám a očekáváním cílového publika. Pro dosažení kýženého 

výsledku je důležité stanovit konkrétní parametry a technické požadavky sloužící jako vo-

dítko v průběhu celého procesu. Postup tvorby započatý plánováním a konceptualizací ná-

sledně přechází do preprodukční fáze, v níž se klade důraz na přípravu natáčení, zajištění 

potřebných zdrojů a prostředků k realizaci. Po jejich získání se proces přesouvá do části 

samotného sběru materiálu, během kterého se zaznamenává videostopa určená k dalšímu 

zpracování, a pak následuje fáze označovaná jako postprodukce. V této fázi se provádí střih, 

aby se zkrátily neatraktivní scény a byly vyzdviženy ty podstatné. Uskutečňuje se barevná 

korekce pro estetičtější a reálnější dojem z prostředí, provádí se úprava zvuku pro lepší au-

tentický zážitek a další úpravy směřující ke kvalitnějšímu výstupu. Po veškerých úpravách 

je video připraveno k distribuci a publikuje se mezi cílovou skupinu diváků prostřednictvím 

různých kanálů a platforem. [63], [64] 

2.8.1 Návrh a plánování 

Začátkem návrhu a plánování se rozumí jisté stanovení cílů za účelem identifikace hlavního 

obsahu sdělení a skupiny diváků, která má být oslovena. Po stanovení těchto kritérií se určuje 

koncept znázorňující celkový styl, atmosféru včetně vizuálních prvků videa a následně i scé-

nář, který popisuje jednotlivé scény, akce a popřípadě monology či dialogy postav.  

Lepší vizualizace a následné interpretace scénáře se záměrem usnadnění komunikace mezi 

členy týmu a predikce vizuálního aspektu videa lze dosáhnout tzv. storyboardem. Jedná se 

o sekvenci nákresů nebo obrázků prezentující záběry plánovaného videa. Součástí koncep-

tualizace je mimo jiné i technická a finanční stránka produkce. Výběr vhodného technického 

vybavení a stanovení finančního rozpočtu spolu s dodržením časového harmonogramu lze 

považovat za klíčový aspekt pro další fáze tvorby digitálního videa. [63], [64] 
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Obrázek 1 Ukázka storyboardu [67] 

2.8.2 Realizace natáčení 

Proces realizace natáčení představuje fázi tvorby digitálního videa, během které se zazna-

menává materiál určený k dalšímu zpracování. Při natáčení je důležité dbát na správnou 

kompozici záběrů, osvětlení a technickou kvalitu zvuku a obrazu, která je monitorována 

a případně upravována na místě pro dosažení optimálního výsledku. Opakování určitých 

scén a pořizování různých záběrů z odlišných úhlů a perspektiv umožňuje větší flexibilitu 

při sestřihu a montáži videa v postprodukční fázi. [63], [64] 

2.8.3 Postprodukce 

Dokončením natáčení přechází proces tvorby digitálního videa do fáze postprodukce, v níž 

se v rámci střihu uskuteční výběr nejlepších záběrů a jejich následné seřazení dle scénáře 

a storyboardu tak, aby byl vytvořen plynulý a koherentní tok videa. U scén se dále provádí 

množství úprav odvíjející se od prvotního konceptu a zachycených záběrů: 

• Barevná korekce pro požadovanou úpravu vizuálního vzhledu, a to vlivem kontrastu, 

expozice a úpravy barev.  

• Přidání efektů, titulků nebo animací pro zdůraznění obsahu nebo jako estetický do-

plněk. 
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• Optimalizace kvality zvuku – odstranění nežádoucího šumu, vyvážení hlasitosti jed-

notlivých elementů včetně synchronizace audia s obrazem a aditivní efekty umocňu-

jící autentický zážitek. [63], [64] 

2.8.4 Export a distribuce videa 

Export zahrnuje konverzi hotového videa do vhodného formátu pro konkrétní použití. Tento 

proces umožňuje správné nastavení kodeku a parametrů, jako jsou rozlišení, snímková frek-

vence a komprese. Vyexportovaným videem se rozumí materiál, který je použitelný k ná-

sledné distribuci. 

Publikace a následné sdílení videa lze zprostředkovat při použití platforem sociálních sítí 

jako je Instagram či YouTube nebo i skrze vysílání v televizních stanicích a streamovacích 

službách. Správně koordinovaná distribuce vede k většímu dosahu a oslovení cílové skupiny 

diváků. [64] 

2.9 Typy záběrů 

Záběr je základním stavebním kamenem v oblasti filmu a videa, který označuje statický nebo 

dynamický snímek zachycující určitou scénu, událost nebo objekt. Jedná se o záznam pro-

vedený kamerou, který divákovi vyobrazuje určitý pohled dění na obrazovce. Záběry mohou 

být odlišného typu, délky a účelu a lze je diverzifikovat podle velikosti zachycující části 

dané scény nebo postavy. [65] 

2.9.1 Velký celek 

Velký celek je druh záběru s účelem vyzdvižení rozsáhlého prostředí a počtu herců. Repre-

zentuje vytvoření dojmu širokého a otevřeného prostoru za účelem zdůraznění představy ve-

likosti odehrávající ho se děje. [65] 
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Obrázek 2 Velký celek ve filmu Avengers: Infinity War [68] 

2.9.2 Celek 

Celkem se v odvětví filmu rozumí typ záběru, který zachycuje celou scénu, postavu nebo 

prostředí. Bývá používán na začátku scény nebo při přechodech mezi jednotlivými částmi 

filmu. Jedná se o záběr, který poskytuje divákům přehled o postavě i celkovém prostoru, do 

kterého je zakomponována. [65], [66] 

 

Obrázek 3 Celek ve filmu Thor Ragnarok [69] 
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2.9.3  Polocelek 

Polocelek je termín používaný v oblasti filmu k označení záběru zachycující postavy po 

okraje záběru. Bývá používán při dialogových scénách nebo při zobrazení postav, které vy-

konávají činnosti převážně ve stojící pozici. Postavy zpravidla bývají středobodem pozor-

nosti a zároveň zobrazovány v kontextu jejich okolí, které má však pouze vedlejší, dodateč-

nou hodnotu. [65], [66] 

 

Obrázek 4 Polocelek ve filmu Avengers: Infinity War [70] 

2.9.4 Velký detail 

Záběr velkého detailu se zaměřuje na výrazně zvětšené zobrazení konkrétní části scény nebo 

objektu. Divák má příležitost vidět zblízka a detailně vybrané prvky, kterými jsou nejčastěji 

přiblížené záběry na oko nebo dopadající objekt. V takových scénách jsou zdůrazněny 

emoce a vytvořené napětí. [65], [66] 

 

Obrázek 5 Velký detail ve filmu Blade Runner [71] 
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2.9.5 Detail 

Detail zachycuje konkrétní část scény nebo objektu s vysokou úrovní detailu. Jedná se o zá-

běr, který se zaměřuje na určitý prvek a umožňuje divákům vidět jeho specifické vlastnosti 

nebo charakteristiky. Zpravidla se využívá ke zvýraznění výrazu obličeje, určitého předmětu 

nebo gesta. [65], [66] 

 

Obrázek 6 Detail ve filmu Avengers: Infinity War [72] 

 

2.9.6 Polodetail 

Polodetail je specifickým typem filmového záběru, který zachycuje horní polovinu postavy. 

Charakterizován je tím, že umožňuje detailnější zobrazení mimiky herce a jeho výrazů, při-

čemž gestikulace rukou může být omezená. Prostředí v záběru může být neostré nebo elimi-

nované, přičemž hlavním záměrem je zachycení mimiky a reakcí postavy. [65], [66] 
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Obrázek 7 Polodetail ve filmu Avengers: Infinity War [73] 
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II.  PRAKTICKÁ ČÁST 
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3 SCÉNÁŘ 

• Cílová skupina: absolventi středních škol se zájmem o vysokoškolské studium ve 

sféře informačních technologií. 

• Délka: kolem 60 sekund (zachovat nynější standard kratšího videa a atraktivní formát 

propagace ve formě ladných přechodů za doprovodu hudby a komentáře tak, aby na 

případného uchazeče nepůsobil zdlouhavě, ale aby naopak rychle získal základní po-

vědomí o dostupných studijních oborech a současně možnostech sportovního a kul-

turního vyžití v rámci města Zlín a jeho okolí).  

Je možné, že video na základě pořízených materiálů bude delší. Cílem je zachovat 

minimálně 1 minutu propagačního formátu videa. V případě natočení většího než 

očekávaného obsahu je ale zároveň žádoucí přiklonit se ke kratší délce videa. 

• Lokace: Zlín a jeho okolí – výhledy od rádiové stanice, příroda, případně i ZOO, 

historické a kulturní památky, kromě FAI i zmínka o ostatních fakultách, koleje…  

• Protagonista: není – důraz je spíš kladen na formu natočení učebního a vzdělávacího 

prostředí s menším důrazem na účinkující. 

• Prostředí ve škole: ideálně domluvit někoho na zpřístupnění a ukázku robotů, kteří 

budou představovat obor automatizace, domluvit přístup do učeben, případně i před-

náškových místností; tohle lze aplikovat na samostatné studijní programy fakulty, 

tzn. softwarové inženýrství, bezpečnostní technologie, ITA a další, ale je potřeba je 

odlišit záběry na specifické prvky studia – jako např. natočení programování na ob-

razovce (softwarové inženýrství), práce se síťovými komponenty (bezpečnostní tech-

nologie) nebo obecněji ekonomika, právo, IT, grafika (ITA). Dále obecné záběry 

z prostředí fakulty a vystavených komponentů ve vitrínách.  

• Představa o realizaci:  

• v průběhu videa bude doprovodný hlasový komentář česky nebo anglicky 

(třeba to bude vnímáno jako forma určitého odlišení v případě angličtiny, ale 

cílí se převážně na české absolventy SŠ/gymnázií…); 

• prvních cca 15 až 20 sekund – záběry z prostředí Zlína, úvodní introdukce ve 

formě kulturních nebo přírodních památek/okolí, postupně se překlene na zá-

běry FAI za doprovodu hudby s ladnými přechody; 

• 20. až 45. sekunda – představení oborů tak, aby korespondovaly s již zmíně-

nými kritérii (roboti, učebny, programování…); 
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• 45. až 55. sekunda – rychlé prostřihy na prostředí fakulty – menza, vitríny, 

sportoviště…; 

• posledních 10 až 15 sekund – přechod na logo fakulty se zobrazeným textem 

FAI a prolnutí na samotnou budovu FAI.  
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4 REALIZACE NATÁČENÍ 

Na základě prvotní konceptualizace scénáře následovala realizace samotného procesu natá-

čení. Hlavním cílem byla orientace na proces sběru materiálu, který se svou věcností i vizu-

álním stylem co nejvíce podobá původnímu návrhu propagačního videa. Pořízení videostopy 

bylo provedeno prostřednictvím již vlastněné techniky – mobilní telefon iPhone 11 Pro Max 

za použití stabilizátoru ZHIYUN SMOOTH-Q (gimbalu), a to z důvodu eliminace nežádou-

cího třesu rukou. Za použití tohoto vybavení se pak divákovi dostává plynulejšího a estetič-

tějšího požitku z pořízeného záznamu. 

4.1 Zařízení pro záznam materiálu 

Technika využitá pro záznam videa je chytrým zařízením od značky Apple. Vzhledem k do-

stupným možnostem se jedná o zařízení, které zajistí potřebnou kvalitu videa bez nutnosti 

nové investice do jiných alternativ. Zaznamenané video odpovídá předpokládané vizuální 

kvalitě a dalším nárokům na manipulaci. 

Výhodou při použití mobilního zařízení je jeho skladnost a flexibilita. S telefonem bylo 

snadnější manévrovat v různých prostředích a situacích během natáčení. Za pozitivní aspekt 

použití tohoto konkrétního modelu lze považovat i rychlou změnu mezi šířkou záběru kvůli 

třem objektivům, kterými telefon disponuje.  

4.2 Parametry videozáznamu 

Většina pořízených záběrů byla natočena v rozlišení 4K při snímkové frekvenci 30 FPS. 

Důvodem je imitace přibližně stejných vlastností, jako bývá pravidlem v kinematografii. 

Promítaný obraz působí na diváka filmovým dojmem a dodává určitou formu dramatičnosti. 

Určité úseky byly natočeny za použití snímkové frekvence 60 FPS kvůli využití tohoto ma-

teriálu na zpomalený záběr. Vyskytly se i případy, převážně v místnostech s umělým osvět-

lením bez přístupu denního světla, kdy bylo nezbytné použít snímkovou frekvenci o hodnotě 

24 FPS pro vyvážení frekvence blikání světla se zaznamenávaným videem. 
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5 STŘIH A POSTPRODUKCE 

Střih a postprodukce představuje zásadní fázi v procesu tvorby videa, kdy dochází k přeměně 

původního natočeného materiálu do finální podoby, která má za cíl zefektivnit vizuální i ob-

sahovou stránku, jež je prezentována ve snaze zaujmout potenciální studenty a informovat 

je o možnostech studia na Fakultě aplikované informatiky (FAI). V rámci tohoto bodu os-

novy budou popsány jednotlivé kroky střihu a postprodukce formou tutoriálu, které byly 

realizovány pomocí programů Adobe Premiere Pro a Adobe After Effects. Bude zahrnovat 

popis technik, nástrojů a postupů, které byly použity k dosažení požadovaného výsledku 

propagačního videa. Společně s rozhodnutími o výběru vhodného materiálu, jeho organizaci 

a kompozici, prací se zvukem, tvorbou přechodů, text trackingem a dalšími se jedná o klí-

čové prvky, které ovlivnily finální výstup. 

Pro zpracování závěrečné části práce byl využit stolní počítač s následujícími technickými 

specifikacemi. Hardware obsahoval procesor Intel Core i5 6600k s frekvencí 4.2 GHz, 

32 GB DDR4 operační paměti, grafickou kartu Asus Strix GeForce GTX 1060 s 6 GB pa-

měti a SSD disk Kingston 240 GB; práce probíhala v operačním systému Windows 10. 

5.1 Výběr audia a záběrů 

Závěrečná fáze zpracování videa započala výběrem vhodné hudby a audio efektů z interne-

tového portálu Artlist, která má za účel na uchazeče zapůsobit veselým dojmem. Možnost 

stažení hudby i efektů je uživatelům zpřístupněna po uhrazení poplatku za předplatné, které 

ale lze zrušit. Důraz byl kladen i na rytmus kvůli vytvoření určitého vzorového rámce opa-

kujících se pasáží písničky pro případnou možnost zkrácení nebo provázání s jiným úsekem. 

Příslušné přechody k rytmu hudby jsou obohaceny o audio efekty.  

Natočené záběry jednotlivých fakult, města Zlín a prostředí Fakulty aplikované informatiky 

zahrnující odpočinkové zóny, stravovací zařízení a sportovní areály byly důkladně vybrány 

s ohledem na požadovanou potřebnou kvalitu a následnou manipulaci. Podstatným krokem 

bylo zajištění stability obrazu a optimální kompozice pro aplikaci vizuálních efektů, jako je 

text tracking a maskování pro plynulé přechody. Důraz byl kladen na dodržení jednotné 

snímkové frekvence a rozlišení videa. Většina materiálu byla natočena ve formátu 4K při 

snímkové frekvenci 30 snímků za sekundu (FPS). Pro situace vyžadující zpomalení záběrů 

nebo synchronizaci s okolním světlem byla preferována snímková frekvence 24 FPS. 
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5.2 Střih v programu Adobe Premiere Pro 

Výběrem vhodné hudby a kvalitních záběrů byla dokončena první fáze práce a nastal proces 

střihu. Pro tento účel byl zvolen software Adobe Premiere Pro, specializovaný nástroj určený 

pro profesionální střih a postprodukci videa. Uživatelům poskytuje širokou škálu funkcí 

a nástrojů pro práci s videem, mezi které patří zejména úprava barev, korekce obrazu, tvorba 

titulků a přechodů, stabilizace videa a mnoho dalšího. 

 

Obrázek 8 Prostředí programu Adobe Premiere Pro [autor] 

Jedná se o aplikaci dostupnou pouze na základě měsíčního nebo ročního předplatného.   

S ohledem na pozdější využití programu Adobe After Effects se ukázala jako výhodná alter-

nativa možnost využití předplatné služby Adobe Creative Cloud, která uživatelům umožňuje 

přístup ke všem dostupným aplikacím podle jejich výběru či potřeb. Tato služba nabízí ně-

kolik variant plateb, které se liší podle časového rámce a záměru uživatele – měsíční nebo 

roční předplatné s pravidelnými měsíčními platbami, nebo jednorázová platba za celoroční 

předplatné za zvýhodněnou cenu. Diverzifikace výše předplatného se udává i dle účelu vy-

užití, který se rozděluje na komerční a nekomerční. Například pro studenty je k dispozici 

zvýhodněný tarif, avšak bez možnosti komerčního využití softwaru. 

5.2.1 Import a uspořádání 

Vložení neupraveného materiálu do softwaru je snadno realizovatelné pomocí operace 

Drag&Drop, která umožňuje přetahování videí i jiných souborů přímo do panelu prohlížeče 
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médií. Při práci s větším množstvím videoklipů je efektivní vytvářet složky přímo v tomto 

pracovním okně. Všechny složky jsou systematicky pojmenovány dle obsahu příslušných 

videí, což usnadňuje navigaci a správu. Pro uživatele se tak jedná o lepší uspořádání mate-

riálu a zabrání vytvoření nepřehledného seznamu videí.  

  

Obrázek 9 Import a uspořádání v panelu prohlížeče médií [autor] 

Na základě přibližně stanovené délky a obsahové roviny propagačního videa, která byla spe-

cifikována v rámci scénáře, následoval krok, během něhož byla hudba zkrácena tak, aby 

odpovídala předurčené délce, avšak s důrazem na plynulý přechod mezi jednotlivými úseky 

a zachování kontinuity zvukové stopy. Natočené videoklipy byly systematicky uspořádány 

na časovou osu v souladu se stanovenou hierarchií, aby bylo dosaženo požadovaného tempa 

prezentace. Audiostopa, která se k videoklipu automaticky váže, je pro účely propagačního 

videa ve většině případů nežádoucí a je nutné ji odebrat. Proces odstranění je velmi nená-

ročný a docílí se ho kliknutím pravým tlačítkem na videoklip, který je v časové ose, s ná-

sledným zvolením možnosti Unlink. Video a audio stopa po tomto kroku není nadále sesku-

pena a audio lze jednoduše smazat. 
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Obrázek 10 Uspořádání v časové ose a odstranění audia [autor] 

5.2.2 Střihové nástroje 

V aplikaci Adobe Premiere Pro existuje více způsobů, jak zkrátit videoklip. Jednou možností 

je použití střihového nástroje pro úpravy (Razor Tool), který je symbolizován ikonou žiletky, 

nebo ho lze spustit klávesou „C“ a poté, přejetím myší nad požadovaným místem v časové 

ose společně s následným kliknutím levým tlačítkem, lze snadno rozdělit video nebo jiný 

prvek na dvě části. Vybraná nepotřebná pasáž může být následně odstraněna klávesou „De-

lete“ nebo alternativně klávesovou zkratkou „Alt + Backspace“, která přesune obsah násle-

dujícího místa na místo vymazaného prostoru.  

 

Obrázek 11 Střih videa pomocí nástroje Razor Tool [autor] 
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Další metodou pro zkrácení úseku videa je přetažení koncového nebo počátečního bodu do 

požadované pozice v časové ose. Tento proces je známý pod názvem Trim. Během fáze 

střihu byly tyto nástroje a operace opakovaně aplikovány na videoklipy, hudbu a zvukové 

efekty. Střihové úpravy jsou koncipovány s ohledem na rytmus hudby, ale v některých pří-

padech nebylo možné tohoto cíle plně dosáhnout, zejména kvůli nutnosti zachování délky 

ukázky, například v rámci prezentace studijních oborů. 

 

Obrázek 12 Funkce Trim pro zkrácení úseku videoklipu [autor] 

5.3 Přechody 

Pro dosažení plynulého a esteticky přitažlivého dojmu z videa se v postprodukční fázi im-

plementují přechody mezi jednotlivými videoklipy. Přechodů existuje obrovská škála 

a volba se odvíjí dle faktorů použitelnosti, atmosféry a celkových kompozičních možností. 

Pro konkrétní případ prezentace propagačního klipu jsem preferoval využití úderného 

a rychlého stylu přechodů a střihů.  

5.3.1 Speed ramp 

Termín „speed ramp“ je v rovině úpravy videa označení pro typ přechodu, který zahrnuje 

zrychlení koncové části prvního videoklipu a zároveň zrychlení počáteční části druhého vi-

deoklipu. Pro dosažení vizuálně lepšího přechodu je ideální, když se obraz pohybuje v bodě 

přechodu stejným směrem.  

Prvním krokem postupu při vytvoření tohoto efektu v softwaru Adobe Premiere Pro je klik-

nutí pravým tlačítkem myši na ikonu efektů (FX) příslušného videoklipu a následné vybrání 

přes menu Time Remapping > Speed. Tímto krokem dojde ke změně původního lineárního 

průběhu průhlednosti (opacity) na rychlost (speed) v časové ose. Prvek rychlosti je možné 

nalézt v okně Effect Controls, kde je zároveň zobrazena časová osa.  



UTB ve Zlíně, Fakulta aplikované informatiky 41 

 

 

Obrázek 13 Změna lineárního průběhu průhlednosti na rychlost [autor] 

Aplikace efektu zrychlení se provede pomocí kliknutí levého tlačítka myši na ikonu stopky 

u prvku Speed, čímž se udělá klíčový snímek (keyframe) v časové ose daného videoklipu. 

Následným tažením osy směrem nahoru dochází ke zvýšení rychlosti přehrávání v dané pa-

sáži videostopy. Více gradientního průběhu přechodu lze dosáhnout při použití dvou klíčo-

vých snímků a následného upravení křivky mezi těmito body. 

 

Obrázek 14 Tvorba efektu pomocí klíčových snímků funkce Speed [autor] 
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5.3.2 Maskování 

Dalším přechodovým efektem využitým v rámci této práce je tzv. maskování. Tento efekt 

spočívá v překrytí obrazového záznamu jiným videoklipem. Pro vizuálně atraktivní aplikaci 

tohoto efektu je nezbytné, aby natočený videoklip obsahoval vertikální nebo horizontální 

prvek, který se rozprostírá přes celou výšku nebo šířku obrazu. 

Ve vytvářeném videoklipu se tento efekt vyskytuje při přechodu například z prostoru stra-

vovacího zařízení (menzy) na sportoviště. Dominantní přechodový prvek v tomto případě 

představuje nosný rám skel, který je vertikálně umístěn přes celou výšku obrazového zá-

znamu. Proces vytvoření tohoto přechodového efektu se provádí kliknutím na ikonu pera 

v okně Effect Controls umístěnou pod záložkou Opacity (průhlednost). Následně je otevřeno 

rolovací okno s dalšími možnostmi. Mask Path slouží k manipulaci s cestou nebo pozicí 

vytvořené masky v daném snímku videa. Pro dosažení hladkých hran vytvořené cesty masky 

je možné využít funkci Mask Feather, čímž se získá autentičtější efekt, jako by byl přecho-

dový záznam organicky začleněn do původního videa. Mask Opacity určuje průhlednost 

masky a Mask Expansion reprezentuje zvětšení od původní cesty masky. 

 

Obrázek 15 Nástroje pro vytvoření maskovacího přechodu [autor] 
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Princip tvorby maskovacího přechodu spočívá v použití klíčových snímků funkcí Mask Path 

a Mask Feather v jednotlivých snímcích videoklipu a přizpůsobení cesty masky v přehráva-

cím okně. Pro přechod na další snímek je nejjednodušší cestou kliknout na ikonu vedle pře-

hrávání v přehrávacím okně. V následujícím snímku je potřeba opět upravit cestu masky tak, 

aby pokrývala požadovanou část videoklipu. Tento postup je opakován, dokud není maska 

přizpůsobena svým rozložením na celou přehrávací plochu původního videoklipu. Záznam, 

na který se v rámci efektu přechází, musí být v časové ose organizačně přizpůsoben pod 

vrstvou videa, ve kterém se maska nachází, a zároveň začínat v klíčovém snímku vzniku 

cesty masky. 

 

Obrázek 16 Proces vytvoření maskovacího přechodu [autor] 

5.3.3 Rozmazané přiblížení a oddálení 

Efekt rozmazaného přiblížení a oddálení je v práci použitý dvakrát. Jednalo se o vhodnější 

alternativu místo již zmíněného Speed rampingu, jelikož použití tohoto efektu by vytvořilo 

nežádoucí a divácky neatraktivní přechod.  

Cílem vytvoření tohoto efektu bylo jeho určení pro opakované použití a byl tak časově efek-

tivní. Software Adobe Premiere Pro nabízí pro tento účel vrstvu úprav (Adjustment layer). 

Tuto vrstvu určenou pro úpravy lze vytvořit prostřednictvím panelů prohlížeče médií. Na-

stavení rozlišení, snímkové frekvence a poměru stran pixelů bylo přizpůsobeno parametrům 

videí, na které byl efekt aplikován, tedy rozlišení 4K (3840x2160 pixelů), snímková frek-

vence 30 FPS a poměr stran pixelů 1.0. Vrstva úprav byla následně přetažena do časové osy.  
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Obrázek 17 Vytvoření vrstvy pro úpravy [autor] 

V panelu Efektů byl vyhledán a poté, na vrstvu úprav, aplikován efekt Transform, ve kterém 

byly prováděny další úpravy. V rámci nastavení tohoto nástroje byla pozměněna hodnota 

úhlu závěrky (Shutter Angle) na 360. V místě střihu mezi dvěma videoklipy je nastavena 

funkce měřítka (Scale) s hodnotou přiblížení 300. Klávesou šipky vlevo je možné se přesu-

nout v časové ose o pět snímků zpět. Zde byla aplikována, na místo výskytu prvního klíčo-

vého snímku, hodnota měřítka (Scale), jež byla navrácena na původní hodnotu 100.  

 

Obrázek 18 Vytvoření klíčových snímků a úprava hodnot [autor] 
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Stejným způsobem byl upraven i časový úsek druhého videoklipu, kdy pátý snímek předsta-

vuje návrat do původního stavu. Po dokončení této operace byl první klíčový snímek nasta-

ven na Ease Out a poslední klíčový snímek na Easy In. Tyto prvky jsou určené pouze pro 

upravení průběhu křivky efektu. Po rozkliknutí položky Scale v panelu Effect Controls byly 

upraveny křivky tažením za příslušné body, aby na diváka přechod zapůsobil vizuálně lep-

ším dojmem. 

 

Obrázek 19 Nastavení hodnot v klíčových snímcích a úprava křivky [autor] 

5.4 Audioefekty 

Rušné prostředí při natáčení, ať už vlivem jedoucích aut nebo jiných šumivých ruchů, je při 

natáčení běžný jev. Nežádoucí audio, které doprovází video, proto vyžaduje ve fázi postpro-

dukce ztlumení nebo kompletní odstranění. Zachování autentického prostředí je ve videu 

poté doplněno o zvukové efekty, například rušné ulice, basový šum při zrychlených přecho-

dech nebo kliknutí myši. Stejně jako použitá hudba byly i audioefekty stažené z interneto-

vého portálu Artlist. Případy výskytu příliš dlouhého zvukového efektu byly ošetřeny stři-

hem nebo zkrácením za použití nástroje Razor Tool. 

5.5 Animace přechodu s doménou a logem fakulty 

Barevný přechod v oranžových odstínech byl vytvořen v programu Adobe Illustrator. Jedná 

se o software specializovaný na vektorovou grafiku. Vytvoření kruhu je relativně jednodu-

chý proces, při kterém je v panelu nástrojů vybrána položka s ikonou kružnice. Kruh je 
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vytvořen kombinací kláves „Alt + Shift“ společně s levým tlačítkem myši a následným ta-

žením na kreslicím plátně. Tento výsledný objekt je poté označen a nastaven s přechodovou 

výplní. Počáteční a koncová barva se vybírá z dostupné barevné palety.  

 

Obrázek 20 Proces vytvoření kruhu s barevným přechodem [autor] 

Výstup byl s ohledem na účel použití vyexportován přes menu File > Export As do formátu 

PNG s průhledným pozadím. Logo Fakulty aplikované informatiky včetně textu s doménou 

je možné stáhnout v PNG formátu z oficiálních stránek Univerzity Tomáše Bati. 

5.5.1 Vytvoření animace v Adobe Premiere Pro 

Potřebné vizuální prvky pro vytvoření efektu v softwaru Adobe Premiere Pro byly připra-

veny pro import, který se prováděl identickým, již popsaným způsobem. Původní návrh scé-

náře obsahoval doprovodný hlasový komentář v průběhu celého videa. Od této myšlenky se 

sice opustilo, ale k zakomponování hlasu došlo na konci videa.  

Současné inovační technologie umožňují využití bezplatných služeb různých umělých inte-

ligencí. Mezi ně se řadí například známý ChatGPT od OpenAI nebo umělá inteligence Mid-

journey, která se specializuje na vytváření uměleckých obrázků a vizualizací. I generovaný 

mluvený projev na základě psaného textu našel své zastoupení. Jedná se o umělou inteligenci 

s názvem ElevenLabs. Tento nástroj nabízí širokou škálu dostupných virtuálních hlasů a na 

základě psaného textu vygeneruje audiosoubor s nahrávkou zcela bezplatně, ale jeho použití 

je omezeno počtem znaků. Pro účely komentování krátkých proslovů, které mají zaujmout 

posluchače, je tento nástroj ideální volbou.  
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Do panelu určeného pro vstupní text bylo vloženo – „Tohle je nový začátek. Studuj na Fa-

kultě aplikované informatiky.“ Dodatečným nastavením, které může uživatel upravovat, do-

šlo k odladění barvy hlasu a poté byl audiosoubor stažen a importován do časové osy pro-

gramu Adobe Premiere Pro. 

 

Obrázek 21 Generování hlasu a úprava vlastností [autor] 

Kompoziční rozložení prvků barevného přechodu a loga fakulty s doménou bylo uspořádáno 

v časové ose tak, aby korespondovalo s postupným uticháním hudby na konci videa. Pro 

vytvoření efektu zobrazení gradientního kruhu byl využit panel Effect Controls, ve kterém 

se upravily klíčové snímky pomocí nástroje Scale. První klíčový snímek zachycuje pouze 

minimální část kruhu.  
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Obrázek 22 Vytvoření klíčového snímku v nástroji Scale pro barevný kruh [autor] 

Druhý (závěrečný) klíčový snímek obsahuje barevný přechod přes celou plochu a je zobra-

zen až do konce videa. Vyobrazení loga s doménou bylo zpracováno stejným postupem s tím 

rozdílem, že byly přidány další dva klíčové snímky, které následují krátce po zobrazení 

textu, vytvářejíce iluzi kliknutí na odkaz s doplňujícím audioefektem stisku tlačítka myši. 

 

Obrázek 23 Efekt kliknutí a zobrazení gradientu přes přehrávací plochu [autor] 
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5.6 Textové zobrazení oborů 

Komunikaci s diváky lze ve videu navázat několika způsoby. Jedním z nich je například do-

provodný hlasový komentář. Pro případ propagačního videa jsem zvolil postup textové 

formy komunikace, kde jsou obory představeny pomocí psaného slova. V rámci videoklipu 

jsou využity dva způsoby zobrazení textu, a to standardní a tzv. text tracking, který je popsán 

v kapitole zahrnující program Adobe After Effects. 

Standardní text lze v oblasti videa vyložit jako stacionární, nehybný text, který nepodléhá 

žádným dalším postprodukčním úpravám. Textové vrstvy v programu Adobe Premiere Pro 

však jsou obohaceny o efekty a nástroje, které umožňují animaci vstupu s rozmazaným efek-

tem při pohybu a gradientní změnou průhlednosti při vyobrazení a odchodu.  

5.6.1 Postup při vytvoření textového komunikačního nástroje 

V uživatelském rozhraní softwaru Adobe Premiere Pro se nachází panel nástrojů s ikonou 

ve tvaru písmene T. Aktivací tohoto nástroje a následným kliknutím na přehrávací plochu 

v souladu s časovou osou je možné do videa vložit textové pole a upravit parametry, jako 

jsou například mezery mezi jednotlivými znaky, velikost řádkování nebo velikost písma. Je 

nutné zajistit, aby vrstva obsahující text byla umístěna nad vrstvou s videoklipem, na kterém 

má být text promítán. 

 

Obrázek 24 Text a jeho upravitelné parametry [autor] 
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Pro aplikaci efektu „zjevení“ a odchodu směrem z levé strany obrazovky se v panelu Effects 

Controls upravuje vlastnost Position (pozice) a nástroj Opacity (průhlednost). Efekt rozma-

zání pohybu (Directional Blur) byl na text aplikován ze záložky Effects. Provedení zahrnuje 

aktivaci a následné nastavení pozice, průhlednosti a rozmazání textu v klíčových snímcích.  

 

Obrázek 25 Nastavení hodnot v klíčových snímcích jednotlivých efektů [autor] 

5.7 Použití softwaru Adobe After Effects 

Adobe After Effects je profesionální nástroj pro tvorbu vizuálních efektů a animací vyvinutý 

společností Adobe Systems. Uplatňuje se ve filmovém průmyslu, televizní produkci, ale 

i v digitálním designu. Software umožňuje uživatelům vytvářet komplexní grafické efekty 

a animace, které lze integrovat do videí, filmů nebo jiných multimediálních projektů. 

Adobe After Effects disponuje širokou škálou funkcí a nástrojů, mezi které se řadí například 

vrstvení, práce s maskami nebo sledování pohybu (motion tracking). Uživatelům je umož-

něno na základě univerzálnosti pracovat s různými formáty a video kodeky souborů. Prová-

zanost ekosystému programů Adobe poskytuje díky integraci produktů, jako je Adobe Pre-

miere Pro a Adobe Photoshop, snadno přenositelné projekty mezi jednotlivými aplikacemi 

a využití jejich synergie pro tvorbu projektů.  
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5.7.1 Text tracking a Solid tracking 

V rámci tvorby propagačního videa prezentujícího možnosti studia na Fakultě aplikované 

informatiky byla využita specifická technika sledování textu známá jako text tracking. Pro-

ces vytvoření tohoto vizuálního efektu bude popsán s důrazem na použité nástroje a funkce. 

Propojenost mezi aplikacemi Adobe poskytuje možnost integrace záznamů mezi softwarem 

Adobe Premiere Pro a Adobe After Effects. Kvůli opakovaným chybovým hlášením, která 

bránila vzájemnému otevření záznamů, však bylo nezbytné zvolit alternativu exportova-

ného, již sestříhaného videa doplněného o efekty. Takto upravené video bylo následně ote-

vřeno jako samostatný videosoubor v kompozičním prostředí programu Adobe After Effects. 

Importované video bylo vloženo do časové osy a další důležitý krok zahrnoval znovuvytvo-

ření střihu pro záběry, na které se efekt sledování textu aplikoval. Program bohužel nedis-

ponuje příliš intuitivním stylem střihu jako Adobe Premiere Pro. Zde je potřeba v časové ose 

lokalizovat snímek určený pro střih a následně využít klávesovou zkratku „Ctrl + Shift + D“ 

nebo alternativně zvolit možnost z rozbalovacího okna Edit > Split Layer. Vystřižená část 

videa se přesune do nové vrstvy.  

 

Obrázek 26 Kompoziční rozložení a střih videa [autor] 

Panel Effects & Presets obsahuje širokou škálu efektů, ale pro původní záměr integrace sle-

dování textu je potřeba v okně vyhledat pouze nástroj 3D Camera Tracker a následně jej 

přetáhnout do požadovaného a upravovaného videoklipu. Software automaticky spustí 
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analýzu prostředí a postupuje snímek po snímku. Po dokončení zobrazí body, tzv. track 

points, které jsou následně využity k vytvoření nové vrstvy textu a kamery.  

Program po analýze prostředí zobrazí kromě sledování textu také možnost sledovat pevný 

obraz, což lze v interpretaci chápat jako zasazení statického obrazu (nehybného videoklipu 

nebo obrázku) do okolního prostředí s nezměněnou pozicí během pohybu kamery. Tato mož-

nost byla využita například při zobrazení uživatelského prostředí programu Cisco Packet 

Tracer na plátně v přednáškové místnosti. Funkce byla rovněž kombinována se sledováním 

textu, který se zobrazuje na vedlejším promítacím plátně.  

 

Obrázek 27 Postup při vytvoření sledování textu a obrazu [autor] 

Poloha textu, odvozená z určených sledovacích bodů, vyžaduje obvykle úpravu pomocí ná-

stroje Transform. Umístění textu lze upravit tahem za šipky příslušných os X, Y a Z. Další 

důležitou úpravou je rotace v těchto osách, která je žádoucí v případě důrazu na vizuálně 

autentičtější dojem ze zasazení objektu do reálného prostředí. 
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Obrázek 28 Úprava rotace v příslušných osách [autor] 

5.7.2 Animace fixy 

Odlišení Fakulty aplikované informatiky a zdůraznění příslušných studijních oborů od ostat-

ních fakult bylo provedeno animací zakroužkování nápisu FAI a doplnění o zvukový efekt 

fixy. Prvním krokem realizace byl proces vytvoření nové vrstvy (Layer > New > Solid) 

a zobrazení potřebných nástrojů – Brushes a Paint prostřednictvím nabídky Window. Ná-

sledně byl zvolen štětec dle preferencí a upravena položka Diameter pro zvětšení tahu. V pa-

nelu Paint je nástroj Duration nastaven na možnost Write On. Tato úprava vede k automa-

tickému vytvoření klíčových snímků během kreslení uživatele. Program na výstupu zobrazí 

identickou animaci kresby. 

 

Obrázek 29 Princip tvorby animace fixou [autor] 
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Implementace animace na konkrétní videoklip s popisem Fakulty aplikované informatiky 

byla provedena zvolením možnosti kresby na transparentní pozadí v panelu Effect Controls. 

Poloha výsledného efektu byla upravena na základě změn hodnot v klíčových snímcích ná-

stroje Position. Postupné zvýšení průhlednosti je ošetřeno funkcí Opacity. Ve videu tak do-

chází ke gradientnímu splynutí s okolním světem.  

 

Obrázek 30 Úprava klíčových snímků nástrojů Position a Opacity [autor] 

5.8 Export  

Vzniklá chybová hlášení při pokusu o otevření záznamu v Adobe After Effects byla vyřešena 

alternativním způsobem exportu videa ve vysoké kvalitě v programu Adobe Premiere Pro 

a jeho následném, opětovném importu do softwaru bez varovné notifikace.  

5.8.1 Export v Adobe Premiere Pro 

Proces exportu videa v softwaru Adobe Premiere Pro se provádí přes menu File > Export > 

Media. V exportním panelu jsou k dispozici různě nastavitelné parametry, které je nutné 

správně nakonfigurovat. Pro export byl vybrán formát H.264 s předvolbou (preset) odpoví-

dající vlastnostem zdrojového materiálu a s vysokým adaptivním datovým tokem. Tato 

vlastnost se však změní na vlastní přednastavení (v případě úprav), jako je například zvolení 

položky renderu v maximální kvalitě. Cestu pro uložení exportovaného videa lze zobrazit 

kliknutím na odkaz vedle názvu výstupního souboru a vybrat požadovanou adresu. 



UTB ve Zlíně, Fakulta aplikované informatiky 55 

 

 

Obrázek 31 Export a změna parametrů v programu Adobe Premiere Pro [autor] 

Za účelem zvýšení kvality byla v záložce Video zvolena možnost renderování v maximální 

hloubce a využití nejvyšší kvality renderování. Následně stačí kliknout na tlačítko Export 

a počkat na dokončení procesu. 

 

Obrázek 32 Zvolení vlastností pro vyšší kvalitu videa [autor] 

5.8.2 Export v Adobe After Effects 

Proces exportu videa v softwaru Adobe After Effects se liší od postupu v Adobe Premiere 

Pro v několika ohledech. Adobe After Effects například nepodporuje přímý export do 
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formátu MP4. Toto omezení lze obejít pomocí aplikace Adobe Media Encoder, která umož-

ňuje propojení souborů z After Effects.  

Postup exportu začíná přes menu Composition > Add to Media Encoder Queue. Následně 

se otevře okno s kompozicí, která je přidána do fronty exportu v Media Encoderu. Pro export 

byl vybrán formát H.264 s přednastavením (preset) dle uživatelovy preference. Při rozklik-

nutí položky Preset lze dále upravovat velké množství parametrů, jako je například nastavení 

datového toku, audia, titulků atp. Pro dosažení vyšší kvality videa byla zvolena možnost 

renderu v maximální hloubce a použití nejvyšší kvality vykreslování. Dále byla nastavena 

hodnota cílového variabilní datového toku na 110 Mb/s. Po úpravě příslušných hodnot je 

okno nastavení exportu zavřeno a v Media Encoderu lze stisknout ikonu přehrávání. Soft-

ware spustí renderování videoklipu a pro finalizaci stačí počkat na dokončení procesu. 

 

Obrázek 33 Proces exportu videa v programu Adobe Media Encoder [autor] 
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ZÁVĚR 

Hlavním výstupem této bakalářské práce je propagační videoklip představující Univerzitu 

Tomáše Bati ve Zlíně, a především její Fakultu aplikované informatiky, a to včetně popisu 

postupu jeho tvorby. 

První úsek teoretické části bakalářské práce obsahuje krátké rešerše o několika významných 

českých vysokých školách se zaměřením na oblast jejich vlastní propagace. Byly zde roze-

brány zejména specifické a unikátní formy propagačních materiálů, které jednotlivé školy 

využívají. Další úsek bakalářské práce se věnuje rozboru nejdůležitějších parametrů digitál-

ního videa a nástinu některých možností jeho tvorby. Mezi podstatné parametry videa patří 

například snímková frekvence, rozlišení videa, poměr stran nebo použité audio a video ko-

deky. V dalších bodech jsou obecně popsány možnosti postupu tvorby videa a typy jednot-

livých záběrů. 

Praktická část bakalářské práce popisuje samotný průběh přípravy a vyhotovení videoklipu 

propagujícího studium na Fakultě aplikované informatiky ve Zlíně. Začíná návrhem původ-

ního scénáře, který označuje základní časové rozložení záběrů a shrnuje představu o vizuální 

stránce klipu. Následuje pasáž popisující sběr výchozího videomateriálu a specifikaci pou-

žitého záznamového zařízení. Střih a postprodukce uvedené v následujících úsecích práce 

reprezentují závěrečnou část postupu tvorby videa a jsou představeny formou tutoriálu, jenž 

definuje využití technik, programů, postupů a nástrojů, které přispěly k závěrečnému vý-

stupu práce.  
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UTB 

FAI  

VUT 

FullHD 

QHD 

4K 

CBR 

VBR 

FPS 

SSD 

IT 

ITA 

 Univerzita Tomáše Bati 

Fakulta aplikované informatiky  

Vysoké učení technické 

Full High Definition (plné vysoké rozlišení) 

Quad High Definition, rozlišení videa (2560x1440 pixelů) 

Rozlišení videa (3840x2160 pixelů) 

Constant Bit Rate (konstantní datový tok) 

Variable Bit Rate (variabilní datový tok) 

Frames Per Second (snímky za sekundu) 

Solid State Drive („polovodičový disk“) 

Informační technologie 

Informační technologie v administrativě 
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PŘÍLOHA P I: DVD  

Datový nosič DVD obsahuje výsledné video v plné kvalitě, soubor Adobe Premiere Pro, 

soubor Adobe After Effects, soubor Adobe Illustrator a text bakalářské práce. 
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